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INTRODUCTION

GENERAL

This document provides all the information needed to install, evaluate and deploy this KWizCom

product:

® Introduction

= |nstallation Guide

= Administrator Guide
= User Guide
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PRODUCT OVERVIEW

Clipboard Manager for SharePoint allows SharePoint content editors and contributors to easily copy rich
content and images stored on their local pc’s MS Windows clipboard, to SharePoint rich-content fields.

Now you can quickly copy formatted text, tables and images from your MS Office document and paste
into any SharePoint rich-text field!

WHY DID WE BUILD IT?

Customers that are trying to migrate their older document-based knowledgebase to SharePoint Wiki,
find many times that the task is not that easy; an MS WORD document page that includes rich-text,
tables and images cannot be copied just like that, but requires several steps including: saving and
uploading each of the embedded pictures to a SharePoint library, then copy just the pieces of plain text,
reformat the pasted text and embed the uploaded pictures in the right places.

The purpose of the Clipboard Manager for SharePoint is to bypass that obstacle by allowing content
editors simply copy & paste rich-content and images from their local Windows clipboard into SharePoint
rich-text fields — simple and quick!

KEY FEATURES

Feature Clipboard SharePoint
Manager for 2010/2013/2016/
SharePoint 2016

Copy formatted text from MS Office, PDF and other text \' Without images

documents

(including tables and images)

Copy images from the Windows clipboard and paste into \'
SharePoint rich-text fields
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INSTALLATION GUIDE

SOFTWARE REQUIREMENTS

SERVER REQUIREMENTS
®  SharePoint Server/Foundation 2010/2013/2016/2016

CLIENT REQUIREMENTS

= Microsoft Internet Explorer 9 +, Google Chrome (latest version), Firefox (latest version)
=  Windows 8+
=  Microsoft Office WORD 2010/2013/2016

INSTALLATION PROCEDURE

SHAREPOINT 2010/2013/2016
1. Login as SharePoint administrator account to your SharePoint front-end server.

2. Browse the product’s page on KWizCom’s website and click the “Go” link under the “Install using
our Web Installer” section.

This will start the KWizCom web installer

Note: The KWizCom Web Installer will automatically offer you to upgrade other existing KWizCom
products on your farm, in case you have old versions installed. You can check which products you

wish to update at this time.

3. In case you prefer just to download the relevant .wsp packages and manually deploy them, then
in the web installer Ul check the “Download only” option (3rd page in the installer’s wizard), OR
download the product WSP packages by clicking their links under the “Download Installable
Packages” section.

After you manually download and unzip the product’s WSP packages or use the web installer to

download the product’s packages, install the KWizCom product by simply running the “SP-
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WSPInstaller” powershell script.

POST INSTALLATION

SHAREPOINT 2010/2013/2016

1. Afterinstallation is complete, 2 new features are added:
a. Clipboard Manager Farm feature
b. Clipboard Manager Site Collection feature
2. If you want the Clipboard Manager to be available across your entire SharePoint farm, activate
the Clipboard Manager Farm feature.
3. If you want to have the Clipboard Manager functionality available only in specific site
collection/s, then leave the farm feature inactive and activate the Clipboard Manager site
collection feature in the required site collections.

UN-INSTALLATION PROCEDURE

SHAREPOINT 2010/2013/2016

Retract the solution using SharePoint central admin or by using stsadm/powershell command line.
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ADMINISTRATION GUIDE

This section describes all administration activities including: product localization, product configuration
and customization.

PRODUCT ACTIVATION

KWizCom products are available for evaluation prior to purchase.

This way you can try our components and verify that they indeed meet your needs. Each evaluation
version contains all features of the component's production version. The only difference between the
versions is that the evaluation version is time-limited and will operate for a period of one month.

Once you decide to purchase a KWizCom component you will need to order and then to activate the
product. The steps that need to be taken next are listed below.

SHAREPOINT 2010/2013/2016

1. Order the product on the KWizCom website — www.KWizCom.com, or contact our sales team at
sales@kwizcom.com.

2. After the order was made, you can activate your installed evaluation version. Activation is done
by the following steps:

a. Open SharePoint Central Admin. On the main “Central Administration” page, you will
see the “KWizCom Features Administration” icon:

Central

Administration & Application Management Iy = System Settings
polication M " 15 Manage Web appll.catluns Ay P Manage servers in this fars
pRication Managemean Create site collections 1% =| Manage services on servel
Systemn Settings Manage service applications Manage farm features
Manage content databases Configure alternate access|
Maonitoring

Backup and Restare Monitoring

Security M Review problems and solutions
Check job status

Wiew Web &nalytics reports

-Q‘t'j Backup and Restore
t @ Perform a backup
“i==a Restore from a backup
Perform a site collection b

Upgrade and Migrati

| Convert farm license type

‘Q Check product and patch |
Check upgrade status

Upgrade and Migration

General Application

settings [/_ 7 Security
Configuration Wizards \ /  Manage the farm administrators group

Configure service accounts

General Application Sattin
\@3} Zonfigure send to connections
Zonfigure content deploym

Manage form templates

+ Configuration Wizard
paths and jobs %4\

(\ KWwizCom Features Administration

kwizComn Products License Management
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b.

C.

d.

Click the KWizCom Features Administration icon. You will be redirected to a page that
allows you to manage all your installed KWizCom products’ licenses:

. i y v

¢ SharePoint 2010 Central Administration » KWizCom Products List - ~
N IlikeIt Tags &

Motes
Search this site.. 2 9

Central Installed Products Licenses scope for this

Adrinistration Site Collection: http://gafarmz0iofe «

application Management  KWizCam Foundation Version: 13.2.35.0

System Ssttings @ SharePoint File Contraller Feature @ ;ictense and suppart services are up to

ate

Monitaring .

Back Rest Version: 11.0.03 AN Llce_nse_ or suppart services are aboutto
ackup ane festore Licanse: Mot licensed. Manage License Expire in less than 30 days

5 t
seunty Status: Please click manage license to start your evaluation or to enter your product license, & License or support services have expired

Upgrade and Migration

General Application T KwizCormn - Knowledge Waorker Cormponents

Settings

Canfiguration Wizards

Click the “Manage License” link next to the product that you wish to activate. You will be
redirected to that product’s license management page:

Product Information

MName: SharePoint File Controller Feature
Version: 11.0.03

Farm License
Farm license applies to all site collections in your farm.

Product Code: Mot requested Request product code and start your evaluation license now!

vieb application or site collection license management

If you hawe a license for ane web application ar site collection, you can enter it here. Simply choose the site collection you wish to activate the license on from the picker and enter the |
Site Collection:  http:/fgafarmz010fe -
Use the form below to activate SharePoint File Controller Feature on one the selected site collection or web application only.

Web spplication License

Web application license applies to all site collections under the same URL, far example: http://sharepoint, http:/#sharepaint/sites/sales stc..

Product Code: Mot requested Request product code and start your evaluation license now!

Site Callection License
Zite collection license applies only to one specific site and it's sub sites,

Product Code: Mot requested Request product code and start yvour evaluation license now!

Click on the “Request product code and start your evaluation now” link.
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A product code will be generated and displayed as in the following screenshot:

Product Information

MNarne: SharePaoint File Controller Feature

Wersion: 11.0.03

Farm License
Farm license applies to all site collections in your farm.

Product Code: THWYATIE[07QZMIUNVEVHIBMMEYHZ QMMS 7865 YYSIVM- SVQMUM MM IMUNRXIK Copy to clipboad
Activation Code: |

Activate n@‘

License Notifications: ||

Update
Optionally, enter your email address to get notified when your license is exceeded or about to expire, To enter more than one email
License type: Ewaluation
Expiration: Thursday, Novernber 18, 2010

wWeb application or site collection license management

If you have a license for one web application or site collection, you can enter it here, Simply choose the site collection you wish to activate the license on fro
Site Collection:  http://gafarm2010fe -

Use the form below to activate SharePoint File Controller Feature on one the selected site collection or web application only.

Wweb application License

Web application license applies ta all site collections under the same URL, for example: http:/fsharepaint, http:/¢sharepoint/sites/sales ete...

Product Code: Mot requested Request product code and start your evaluation license now!

Site Collection License

e. Copy the product code.

f.  Browse the Product Activation Request page on KWizCom’s web site:
http://www.kwizcom.com/ProductReg.

Product Activation Request

In order to deactivate a product please click here.

This Product Activation Form is used to get your product activation key after you have pufthased the product.

Please fill out the following form. Once we get your product activation request,
you by email, along with the activation process description.

product activation key will be sent to

*Customer Name:

*E-mail address:

4

*icense Type: E'

*Share-It Order/Invoice Number: |
*Product Code: |

[ Send Activation Request ]

Copy your Product Code into the “Product Code” field, and after you fill-out all other
form fields, click “Send Activation Request button.
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g. Once your order is confirmed, you will receive the Activation Code for your product by
email.

h. Copy the activation code into the “Activation Code” field in the product’s license
management page and click “Activate now!” link.

Product Information

Marme: SharePoint File Controller Feature
Version: 11.0.03

Farm License

Farm license applies to all site collections in your farm.

Product Code: THWY07I3[07 QZMIUVEYHIGMME, M57385YVYYEIVM- 5YQMUM MMIMYNXIX Copy to clipboad

Activation Code: | & Activate now!

License Notifications: || Update
Optionally, enter your ernail address to get notified when your license is exceeded ar about to expire. To enter mare than ang|

License type: Evaluation

Expiration: Thursday, Movember 158, 2010

veb application or site collection license management

If you have a license for one web application or site collection, you can enter it here, Simply choose the site collection you wish to activate the license
Site Collection:  hitp:/fgafarmzilofe «
Use the form below to activate SharePoint File Controller Feature on one the selected site collection or web application anly.

web Application License

wieb application license applies to all site collections under the same URL, for example: http://sharepaint, http://sharepoint/sites/sales etc...

Product Code: Mot requested Request product code and start vour evaluation license now!

Site Collection License

Site collection license applies only ta one specific site and it's sub sites.

That’s it! Your product is now fully activated.
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CLIPBOARD MANAGER FOR SHAREPOINT CONFIGURATION

‘GENERAL

The Clipboard Manager for SharePoint enables content editors to easily copy & paste rich content from
MS Office documents and images from the user’s local Windows clipboard.

The solution includes the following modules:

Module Description

Clipboard Manager Farm A farm feature enabling activating the clipboard manager for the
Feature entire farm (disabled by default).

Clipboard Manager site A site-collection feature. Use this feature when you do not want
collection Feature to enable the Clipboard Manager across your entire farm, but

only in specific site collections.

Clipboard Manager Settings This page allows configuring settings of the solution in site
page collection, site and list levels. In each level you can inherit from
the parent level or override it with other settings.

KWizCom Client Agent This tool needs to be downloaded by each user after the
Clipboard Manager has been activated, the user will be
prompted to download the tool when trying to paste something
for the 1°' time.

The KWizCom Client Agent runs on the user’s local Windows and
interacts with MS Office and the local machine’s Windows
clipboard.

Before users can start using the Clipboard Manager for SharePoint, there are few settings that require
configuration.

The following sections provide a step-by-step guideline of these required settings.
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‘STEP 1: ACTIVATE THE CLIPBOARD MANAGER FEATURE AT THE REQUIRED SCOPE

If you wish to enable the Clipboard Manager functionality across your entire SharePoint farm, then you
should make sure that the “KWizCom Clipboard Manager for SharePoint farm feature” farm feature is
active.

If you wish to enable the Clipboard Manager functionality only in specific site collections, then leave the
farm feature inactive and activate the “KWizCom Clipboard Manager for SharePoint feature” only in the
requested site collection/s.

STEP 2: CONFIGURE CLIPBOARD MANAGER SETTINGS

After you activate the Clipboard Manager feature at the appropriate scope, you need to configure few
settings. These settings can be configured at the site collection, site and list levels.
By default, each level inherits its parent settings.

To open the Clipboard Manager Settings page, browse the Site Collection/Site/List settings page, and
there click on the “KWizCom Clipboard Manager Settings” link:

) Users and Permissions : Look and Feel

‘:@ People and groups L & I' Title, description, and icon
Site permissions w Quick launch
Site cellection administrators Top link bar

Tree view

Galleries Site theme

[ %’a_ Site columns

—=Z[IE| site content types s | Site Actions
Web parts l 'L‘{J"E" Manage site features
List templates ‘@) Save site as templats
Master pages Site Collection Web Analytics reports
Themes Site Web Analytics reports
Solutions Reset to site definition

Delete this site
Site Administration

Regional settings Reporting Services
Language settings Manage Shared Schedules

Reporting Services Site Settin

..-'_
s
Ll

Site libraries and lists
User alerts

nes I Yy KwWizCom Features

Search and offline availability l.\ Administration

Sites and workespaces —

Workflaws . = KWizCom Clipboard Manager Settings

Wiz s Li 5
Worlflow settings KWizCom Products License Management

Site Collection Administration
I'-Iljill_'ll Search settings
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The following settings page will show-up:

Images library

images should be uploaded.

+ Site settings » Clipboard to SharePoint settings

Use this section to define to which library pasted

D Inherit parent site settings
Upload images to:

[Sit= Assets ______[&d

Create a sub-folder for each user

( Save I Cancel

The following table describes each of the settings page’s fields:

Field Name

Explanation

Inherit parent site settings

Check this checkbox if you want the settings to be inherited from the
upper level.

If you uncheck this checkbox you will be able to override the inherited
settings and configure specific values for the current site/list.

Upload images to

Select the library that will be used to store pasted images.

Whenever an end-user pastes an image to a SharePoint rich-text field,
that image’s file is uploaded and saved in this defined library (By default
it will be “Site Assets” library).

Create a sub-folder for
each user

Check this checkbox if you want a folder to be created for each user that
pastes images. Each user’s folder will store all the images that were
pasted by that user.

In order to save your settings, click the “Save” button.
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GENERAL

The Clipboard Manager for SharePoint allows content editors to easily copy & paste rich content from
MS Office and images from your local PC to SharePoint rich-text fields.

The way you copy and paste remains the same as you always did — simply copy the files or content from
your desktop, and then click “Paste” or press CTRL+V to paste the copied content to your SharePoint
rich-text field.

IMPORTANT COMMENTS

If you are using an older version of the KWizCom Clipboard Manager:

The Clipboard Manager special ribbon buttons has been removed, now we simply override the
existing SharePoint’s “Paste” button.

What happens when you paste?

When you copy rich-text with some images from your MS WORD editor for example, this content will be
pasted to your SharePoint field, and all the copied images will be uploaded to the appropriate
SharePoint library, so this is done automatically for you without any need for you to upload those
images.
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WHAT EXACTLY CAN | COPY FROM MY DESKTOP TO SHAREPOINT RICH-TEXT FIELD?

You can copy and paste rich-content, which includes formatted text, tables and embedded images.
There are 2 ways to copy content from your desktop:

1. Copy content from opened files

So this way you open your MS Office file, such as an MS WORD document, mark the paragraphs
you wish to copy and copy them.

@[ d9-0|s Document2 - Microsoft Word C=nlE)
Home Insert Page Layout References Mailings Review View 4
Ll B2rraent 110213 1:4:1:5:1:6-1:7:1:8:1:9: 110111112 113 1141 15 1 16 17118 119

|Ir]
» [2)] ©

On the Insert tab, the galleries include items
that are designed to coordinate with the overall look of your

ﬂ document . You can use these galleries to insert tables, headers,

footers, lists, cover pages, and other document buildingblocks.
When you create pictures, charts, or diagrams, they also coordinate
with your current document look.

You can easily change the formatting of selected text in the document
text by choosing a look for the selected text from the Quick Styles
gallery on the Home tab. You can also format text directly by using:

Product CR High
| Product Issue Normal |
[Service [3 Normal ]

To change the overall look of your document, choose new Theme elements
on the Page Layout tab. To change the locks available in the Quick
Style gallery, use the Change Current Quick Style Set command.

0 119118 1417 146 1 15 1 14 1 13 (12 (11 (10 1:9+ 1:8+ 17161514+ 13- 1.2 11 1[ o1

« 0 » ¢

o

2. Copy file/s from your Windows explorer
If you wish to copy the entire file/s content to your SharePoint rich-text field, you don’t need to
open the file and mark all its content. Instead, simply go to your windows explorer and copy the
file (or several files). For example, in the screenshot below we have marked an MS WORD
document, a PDF file and an image file:
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= Picture Tools ~ Mew folder
Home Share View Manage

=n 4 Cut Lﬁ_LlNew item ~ A i4 Open
W] Copy path ﬂ Easy access = Edit
uick Copy Paste Move Copy Delete Rename Mew Properties

5 El Paste shortcut to to - folder
Clipboard Crganize MNew Cpen

£ History)

1 » Mew folder

Mame Date mod‘i;‘ied Type Size

= KWizCom_SharePoint_iMUSH-scanning f..  2016-11-27 2:24 PM - Adobe Acrobat D... 1,692 KB
SharePoint Repeating Rows Field Typeus...  2016-11-22810:03 ... Microsoft Word D... 783 KB
@ imagel 2015-12-0111:40...  PNG File 62 KB

When we’ll paste into our SharePoint rich-text field, the WORD and PDF file’s contents will be
pasted along with the copied image.

IMPORTANT COMMENTS

1. 1sttime you try to paste, you will get a message asking you to install the KWizCom Client
Agent tool. You must proceed with this tool’s installation before you can use the product.

2. When you copy & paste a paragraph that includes pictures, behind the scenes those
pictures are uploaded to the SharePoint server. This means that the paste operation takes
more time when you are pasting pictures (depending on the file size of those pictures and
amount of pasted pictures).

3. When copying a PowerPoint file (.pptx), the copied slides are converted to images when
pasted to SharePoint, so if you have for example 5 slides in your PPT file, you will see 5
pasted images — 1 for each slide.

Hidden slides will not be copied.
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COPYING CONTENT OTHER THAN LOCAL DOCUMENTS/PICTURES

When you copy & Paste using the KWizCom Clipboard Manager, the copied rich-content is converted
HTML before it is pasted to your target SharePoint web page.

There are some cases when you copy other content than local documents or images, for example:

copying content from one web page to another.
In those cases you might not want to go through the Clipboard Manager format conversion process
(because it might alter the styles), but instead simply use the out-of-the-box SharePoint paste.

In such cases, when you paste after copying from other sources than local documents, you will see after
you click “Paste” the following “Bubble” offering you to choose the preferred paste option:

D -
Paste options...

— —

O

b

Where:

Paste text only

Use the out-of-the-box SharePoint paste

[ ED

Use KWizCom Paste+

L+
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